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Hello, this is Eric Bobrow. And in this lesson we'll look at power selection techniques. In ArchiCAD there
are many ways to select elements and some of them will be faster for a particular context, so it's
important to be versatile and understand the many ways that you can select things quickly and
precisely. [0:00:21]

Now, with the Arrow tool active, if | go to the Edit menu and | say Select All, it will select everything
that's in the current window that is on a layer that is unlocked. Actually it will select everything even if
it's locked, but of course if it's locked, | can't modify it. Now if | activate a tool like the Wall tool and | go
to the Edit menu, the Select All command has now changed to Select All Walls. So that makes it easy to
do certain types of manipulation. For example, | can go to the Window tool, hit Command+A or CTRL+A,
and it will select all windows, allowing me to perhaps change the material or some other setting about
the windows in general. [0:01:00]

Now if | use the Marquee tool and say draw a box around this area, then if | go to the Edit menu, it will
say Select All in Marquee. | can also use the same shortcut that | have been used to, Command+A or
CTRL+A. You'll notice that it selected all of the objects, the cabinets, etc. in the kitchen as well as the
walls that were enclosed. And even things that were partially enclosed like the staircase and some
other stray elements that were partially enclosed. Now, it turns out that the option for the marquee
can be modified in several ways. [0:01:37]

For example, if | go to the Window tool and still have the marquee active, under the Edit menu you'll see
that same command now selects all windows in marquee. So you can see how easily that can work
selecting all windows. Or if | go to the Object tool here and do Command+A, it will select all the objects
in the marquee. Now another variation that we can do is when we are in the Arrow tool - in the
previous lesson | discussed about how with the Arrow tool, you can have it select things that are
partially enclosed or fully enclosed. So let's see how that works. [0:02:13]

With the partially enclosed, if | go and draw a box like this, you see how it selects a whole bunch of
things that were touched by it. But if | switch this to fully enclosed and do a similar box like that, then it's
only going to select the elements that were fully enclosed by my selection rectangle. Now the selection
rectangle with the Arrow tool turns out its setting, the selection method setting, affects how the
marquee works. So now that | have that changed, if | go to the marquee and do Command+A, it will
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only select the elements that are totally enclosed in the marquee. So in this case, it only selected the
cabinets and the kitchen room tag, and there happened to be a couple of walls here that were selected
as well. [0:03:02]

But definitely knowing that you can restrict the effect of selecting within the marquee to only elements
that are fully enclosed can be very useful from time to time. If | go back to the Arrow tool, | can switch
this at any time, but | have to be in the Arrow tool to make the switch. But then when I'm in the
Marquee tool, | can draw the marquee and fine tune that. As you know, if | move the marquee around,
if I click inside the marquee when I'm not on top of a corner or an edge of an element, | can move this
marquee around until if fits my needs. Of course | can also redraw this, but perhaps if | move this up a
little bit like here, now it's not fully enclosing these two walls, and so if | do the Command+A, select all in
marquee - well of course | change the Arrow tool back, let me go back to the one that says completely
enclosed. [0:03:59]

Now with the select all in marquee, it will only slight the elements that are totally enclosed. So it won't
select for example these lower walls or this right hand wall, because it's not fully enclosed in that. Now
it's interesting that it did select the section marker here, even though it was not fully enclosed. So it
appears to have a little bit of an uneven result in terms of things like markers. But in general, you'll find
this a useful option. Now let's take a look at some other ways that we can control our selection. Let me
get rid of the marquee and just zoom out to Fit in Window. [0:04:39]

Find and Select is under the Edit menu. So Edit, just below Select All is Find and Select. You can also use
Command+F or CTRL+F to bring this up. Now the Find and Select command is very, very flexible and
powerful. Let me just to simplify this to start out. So I'll remove the criteria that was showing and I'll just
say that I'd like to select all types of elements. | hit the plus sign here, and it will select everything just
like the same thing with the Arrow tool. | can also manually switch this to a tool like the Window tool
and hit the plus, and it will select all windows. So that is very similar to just activating the Window tool
and doing Command+A. [0:05:23]

But now let's look at how we can get more specific. For example, if | use the eyedropper for an element
like a window, then it will pick up the settings that I'm working with, a window. If | eyedrop, for example,
an object, then it will say "Object". So | can very quickly by just eyedropping switch it, and now it will
select all the objects. But | can be more specific. For example, this cabinet, this object, if | eyedrop it, |
can also add a criteria that says I'd like to look at the layer. And | add two criteria, it has to be an object
and it has to be on the layer that the object and | just selected or eyedropped was on. If I hit the plus
sign, it will select only those elements that are on that layer. And so if | zoom in on this, you can see
these are the base cabinets on the base cabinet layer. [0:06:16]

Now sometimes we might want to manually modify this. For example, | might want to add another
criteria. For example, | might want to be more specific about things like the material or other things,
perhaps the library name. So if | go to the name, it says that it's Cabinet Base 2. And if | select that you
can see it will select only the elements that have that particular designation. Now, if | want to work with
elements on the multiple layers, | actually can select one than one layer. You might say, well how can an
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element be on more than one layer? It isn't, but there is an option here for "or", which is the default.
Meaning it's going to be on one layer or another. Let me expand this box here, I'll just stretch it to the
right. [0:07:07]

And you can see that if | go to the layer, it won't automatically add a different layer, but | can choose
one. For example, if | know that | want to select upper cabinets as well as lower cabinets here - that's
interesting, it's not showing the - oh there. | had to expand it so we can see that. Now, we can see that
it's going to select the layer for lower cabinets as well as the upper cabinets and | hit the plus sign, and
now it's selecting, you can see the upper ones as well. So we can modify this manually or use the
eyedropper in many cases. Unfortunately, we can't eyedrop let's say the upper cabinets and have it
added into the layer for when you are doing multiple settings like multiple layers, you have to manually
choose which layers you want to add it to. [0:07:57]

Now let's look at some other options. For example, if | eyedrop this window here, now it says that the
window is on a certain layer. So | can select windows that are part of a wall that is on a certain layer.
Now in general, all the walls are going to be on that exterior layer. But let's instead go to the Door tool.
Now I've eyedropped the door, and it says "Walls Interior Layer". So now if | zoom out, you'll see that
when | do the plus sign, it's only selected the interior doors. Why? Because these are the doors that are
on parts of walls that are on this particular layer. So we can be more specific there. [0:08:42]

Another type of option that we may want to consider is sizing. So for example, this window here is a
larger size than some of the other ones. And | might want to change this criteria, instead of layer. |
might want to change it to the width of the window. And then do the plus here, and it selects only the
windows that have that same size as opposed to all windows. Or, if | eyedrop this one here it is a
kitchen, this is a slider type of window. So | might be specific and say what is the name of this window.
The name is a slider, a particular library part. And | can select all windows that have the same name.
And if | wanted to, | can even add a criteria such as the same name and the same width. Things like that.
[0:09:29]

So the more criteria you add in general, the more restrictive the search is, and therefore more powerful
in certainly ways. Now we can also look at the elevation and things like that. So in other words, if |
eyedrop this window here, and | take off the name, so | highlight the criteria here and remove it, and
change the width say for example to the height; then | can do a plus sign, and you can see that even
though these windows in the lower part of the screen are wider, they have the same height as the
windows in the back of the house. They have the same overall height. So we can look at different
settings here. [0:10:09]

So in terms of the settings that you can look at, element type is the most basic. Are we looking for
windows, doors, objects, etc? Pen colors and materials are pretty straightforward as well as fills, line
types. Now it will only look for one pen color or one material which would be considered the primary
setting for that object. So as you know, objects like the door are drawn with different pen colors. One
for the swing that's thinner than the other lines. But it will only look at one pen color. So you may not
find that as useful as some of the other options, but occasionally that will make a difference. [0:10:49]
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For walls, the fill would be the wall type, because you choose a fill to determine how the wall is going to
be drawn. So that would be the composite or single element fill that you are drawing the wall. So you
can select all walls of a particular type. So here's how that would work. If | eyedrop let's say a wall - let
me zoom in on this and then make sure that I'm eyedropping the right thing. And by the way, if we are
over the top of something with the eyedropper, the tab key will also work. So if | hit the tab key, you'll
notice that it's cycling from one wall to another, and then potentially | may be cycling through even slabs
or other elements that might overlap that area. [0:11:33]

Now if I'm in the Wall tool | guess it's preferring that, but | have the Arrow tool active and | hover over
this corner, then when | cycle through the tab key, it will cycle through the objects as well as the walls.
So then the tab key will be more general purpose. But in any event, | eyedrop the wall, and | can go and
say that I'd like to look at the fill of the wall, which you can see is a particular composite. And let me just
zoom out to fit in window here and slide this over a little bit. And when | do the plus sign, you'll see that
it's selected the walls in the main part of the house, but it did not select the walls in the upper right that
are a complex composite. If | eyedrop one of them, then what will happen is if | add a criteria, we can
do thefill here. [0:12:22]

Now this fill actually is not the complex one. If I do a plus sign, it's actually still selecting the previous
one. That's a little confusing. What I’d want in this case is the complex profile of the wall that | had
eyedropped and hit the plus sign. So now it's selecting all the walls that are similar there. So there is a
lot of complexity so to speak here, but generally you can play around to get what you need. So you can
look at the elevation, which would be the base of the wall or the base of the window, and pick all the
ones that have the same elevation. Element ID would allow you to manually type in an ID and find an
element. Perhaps you've gotten an error message related to an element, or you know that a particular
window or door needs to have a different setting. So you can go and find elements that have that ID.
And if you do pick element ID, if you're doing text, you can find things where it contains a certain text
thing. So you can say it contains just the number 7 or something like that. So you can do that, or say
"is", and then you can say it's going to be "W- 07". [0:13:37]

Now in this case | might need to manually change the type from wall to window, and then | can go find
which window that is. And if | hit the plus sign, let's see. Now it looks like | didn't get that. Butif |
eyedrop for example a window here, you can see it's W-03. So | could use this to select W-03, and if
there happened to the two of them or more that all had the same ID, then it would select all of them
that had that ID. So Find and Select is a very powerful option there, and | encourage you to experiment
with this with all of these criteria. | don't think it's necessary to explain all of the different things, but |
will point out a couple of other ones that are sort of special that were added into ArchiCAD 15 or
possibly a little earlier, maybe 14. [0:14:29]

For example, if | look at the option that says library part, there is an option to say, "Is it missing or not
missing?" So that way you can actually, when you have a complex project and you know that some
parts are missing, you can say search for library parts that are missing. And then you will see them
highlighted, you'll just see little dots onscreen. And then you can select them and see which one they
are, decide if you want to delete them or if you need to find the library part perhaps on your hard drive

4 Best Practices Course — Week 15 Part 2 — © copyright 2012 by Eric Bobrow



somewhere. Now that will only show up and all of these things will only show up in the current window.
In other words, I'm looking at the first floor or the main floor plan. It won't be looking for things in the
second floor or in an elevation. [0:15:16]

So you'll need to do this sort of thing for library parts in each window until you find out where a missing
library part is located. This can be a little frustrating, but at least you now have this ability to search this
way. In addition, there are things about hotlink modules and other things about structural function. So
structural function has to do with is it load bearing or not. Element classification, is it considered, if you
have a slab, is that slab considered a slab or maybe it's a roof. Or maybe some other classification.
Position would be inside or outside. So this group of functions was added in recent years, maybe in
ArchiCAD 14 or 15, for selecting elements that might be considered structural. [0:16:04]

You can easily say. "l want to select only the elements that are load bearing", and then see if some of
them perhaps are actually incorrectly classified. And then correct them. So sometimes selecting
elements allows you to see if they have been miscategorized here. And now that we have the
renovation status and filter, we can do things like show me all of the new stuff or all of the existing or all
of the demo. These are these are some options related to renovations that are specific into ArchiCAD
15. [0:16:41]

Now let's just say that | did want to pick out interior walls. Let me eyedrop the interior wall here and
change it to the layer here. Now if | click the plus sign, it will select the interior walls quickly. Perhaps |
want to do this repeatedly. | might want to do some tweaking of the interior walls, may be changing the
materials. We're working with a client and we want to quickly say what would happen if we painted the
walls a different color. What we can do is add a criteria set to this. So when | say "Store As" with the
popup menu, | can say "Interior Walls". Now the name it sort of arbitrary, | could be more specific and
say "Walls on the layer A-Wall-Interior-3D". But just calling it interior walls, as long as it's clear to me or
to other team members, that's what counts. | will say Store It. [0:17:37]

Now you can see here is the criteria set name that showed up. Notice that in the popup menu there are
some built in criteria sets. If | say All Elements, it will say all types of elements and the plus sign would
allow me to select everything. And then there's the all 2D elements, and you hit the plus sign, and you
can see it will select things that are not 3D elements, just the text and the dimensions and the markers
and things like that. Or all 3D elements, and this would be a way to select things that essentially show up
in a model view. Now here's the one that | created, my criteria set, so it's not built in. And here's
interior walls, | can activate that, and when | hit the plus sign, it will bring it up. [0:18:19]

You can create as many of these criteria sets as you like by simply setting up Find and Select the way you
wish and then going and saying you want to store it by a certain name. And in this case | can also
rename or delete ones that I'm not using. Now as a side note, in Teamwork in ArchiCAD 13 and later,
the criteria sets become even more important because you can easily set up a criteria set for a certain
type of work. In other words, you want to work on certain elements, and then with that criteria set ask
the Teamwork BIM server to reserve those elements for you, allowing you to work on them. So the
criteria sets have another function, which is choosing elements that you would like to work on in
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Teamwork. So that is another area, the Reserve Elements dialog uses the same criteria sets as the Find
and Select. [0:19:16]

Now let's go and look at another option here. These are Find and Select. We also have the option to
recall selections. So let me just show - say that | want to select the - and I'll just put this back to sort of a
standard thing. I'm going to select these three bathroom fixtures. So this is easy to do, but we might
have a case where a number of elements that we select took quite a while to be very carefully chosen.
And we might want to show them in 3D or we might want to make some modification, things like that.
So how could we quickly recall this selection set? Well, under the Window menu, Palettes, you'll see
that there is an option called Selections. And this is not very widely used or known about. [0:20:08]

And in the default in ArchiCAD, there's no selections already included, but | can use the popup menu and
say Add a Selection, and let's call this "Bathroom Fixtures". So now if | deselect this and let's go out and
Fit in Window, if | double click on Bathroom Fixtures you can see how it selects it. So basically when
you've got a number of elements selected of any type, then you can give it a name and it will recall that.
Now | don't think that it's attached to copies of those elements. So if | use the plus sign here to select it
- and let me just drag these. Let me just drag them first of all over to the side and then deselect. Now if |
ask it to select, it will remember them, even though they've moved. However, let's say that | will undo
that, and I'll drag a copy of them over here. [0:21:02]

And so when | do that, now there are two copies. If | use the plus sign, it will only selects the ones that
were originally part of this, so not the copies. So this is something that you can use in combination with
the criteria that we had. But it actually is independent. It recalls the actual elements that are chosen as
opposed to the criteria for selection of them. So you can have as many of these selections as you wish,
and you can also do a cross selection with the X. So let's just say that | wanted to do - I'll just do
something arbitrary here. | will select a bunch of elements here, and maybe deselect the markers. So
now l've selected this whole upper right area here. | will save this one, add selection, and then call this
"Upper Right". And then we will select all of the objects. Let's say | will just go to the Object tool, select
all objects, and | will add that as a - actually, let's go all of the objects and say that | would like to add
that as a selection. So we'll just call it "Objects". [0:22:20]

Now if | double click on Upper Right, and then highlight objects and hit X, then it's only going to do the
inner section. So basically, all of the objects within the upper right area. So combinations of this can be
very powerful. And just to review that, select elements that you want and then use the option to add
that selection to the list. Then you have the option possibly to do one type of selection, like all of the
objects, and then intersect that with another selection which are say all of the objects within the upper
right area. So you basically would highlight - let me just do all the objects - and then highlight Upper
Right and do the intersect here. And now it's selecting only those. We can do it in either order in this
case. [0:23:15]

So | can select the Upper Right, and then click on Objects and do the Intersect, it would get the same
result, because it's basically where the two sets have common members. So the Selections palette does
have some different options for visibility, so you can choose how it's going to be listed. But if you use
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this one that gives you all the information, you will see not only the list of different selections, but also
some summaries of what's in there. So if | double click on Upper Right, you can see it showing me 8
objects and 12 walls, etc. here. So I'm going to close the Selection palette. And we'll move on. [0:23:58]

Now, let me bring that open again, sorry - and let's just take the Upper Right here. So with the Upper
Right, I've got a bunch of different element types. And you'll notice that in the Info box it's showing the
Wall tool, and it's saying there are 12 elements. So there are actually 12 walls, but of course we know
that there are a bunch of objects selected. Now suppose | wanted to hide these elements or do some
change to all of them, all of the ones that are selected. Well, if | go open the Wall tool, we will see that
there are 12 walls, and | could put them on a layer, let's just say the one that I've got set up for hiding
things temporarily. And you will see the walls disappear, but not the other elements. Let me just undo
that. [0:24:43]

Now it's clear when I click on the Wall tool, I'm only dealing with walls. But what can be confusing is I've
got a bunch of elements selected, | go up to the Layer Dialog box and change it for example to that
temporary height. It's still only affects the elements that were in the highlighted element type, in other
words, the walls. So let me just undo that. If | want to affect all of them, then | need to use the
Command Edit menu, Element Settings, Edit Selection Set. Which has a keyboard shortcut on the Mac of
Option+Command+T. So hold down the Option and Command keys and type a T. On Windows, it would
be Alt+Ctrl and then type a T. [0:25:27]

Now that brings up a dialog box that actually tells us how many different types of elements we've got
currently selected. And then a bunch of different things that relate to them. And | can switch any of the
things that show up in the selection set. The traditional thing in terms of Edit Selection Set, is just the
layers. So if | put it on the Hide Layer here, and say OK, all of those elements will disappear. Let me just
undo that there. Now if | open up that same command - and | will show you another way to do it. To the
left of the layer popup is this little command button in the Info box that is Edit Selection Set. So that's a
quick way to do it if you don't want to remember the keyboard shortcut that | just mentioned. [0:26:16]

But in addition to this, we can also change the color. For example, | could make all of them red so that
they stand out. And you'll see now as | zoom in they all have this red color on them. Now in terms of
objects, some or many of the objects will have a setting that overrides that, that says, "Don't use the
main pen for the object, use some specific ones for individual lines of the object." So it may or may not
affect the pen in a consistent way, but definitely the command does affect all of the elements that
ArchiCAD - the main pen settings for all of the elements. [0:26:51]

I'm just going to undo that change. So the Edit Selection Set in ArchiCAD 15 now has some additional
options in terms of renovation status. | can say all of these elements are new. So this is something that
did not exist before the renovation tools that were added into 15. But now, that's added into Edit
Selection Set. And in addition, structural function are these, for example, load bearing or non load
bearing, etc. So there are some additional things that we can do and it will affect all elements that are
selected. [0:27:25]
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Now of course, if | choose load bearing and it’s a piece of text or some 2D element, it won't really have
that as an option. But anything that does have that has an option will be changed, whether it's a wall or
a slab or a column or things like that. So Edit Selection Set, very powerful way to modify layers and pen
color for multiple elements of different types that are selected. And in recent versions, we can also
change some other category and tagging here. And we can choose to modify the window colors. So if |
change this to red and modify that, then that's going to actually make those windows at least there's a
red line for part of the window here. So let me undo that. So that's the Edit Selection Set. [0:28:22]

Now, let's look at the option for selecting in 3D, so we're going to switch our focus now. And we'll close
the Selection palette. So when | go to a 3D view, let me switch to a 3D view that has the model layers
turned on. Of course | can go to the Arrow tool and select things. Now, when | select in the middle of
this roof, it's easily selected it because the Quick Select was turned on. Now if | have Quick Select
turned off, and | do the same click, then it's going to draw a selection rectangle around it, which in many
cases is going to be awkward. In other words, it's not going to select what | want, it's going to select a
whole bunch of other things here. [0:29:12]

But turning off Quick Select can be very useful in some limited cases, in 3D for example. And | will show
you. I'm now looking into the building, and you can see that through the window I've got some
furniture. Now, of course | could change the settings of the furniture on the floor plan, but sometimes
you want to do that in 3D. So if | have Quick Select turned on, and | try to select that table, it's going to
select the window that's in the way. Now if | have Quick Select turned off and | click here, it's going to
draw a box. If | draw this box carefully, it's going to select elements within that area. So in this case it's
selected the objects that had hot spots within the little box that | drew. [0:29:55]

Now, if | wanted to be specific about this table, | can draw that box just around one part of the table and
experiment a little bit. But | can easily go and change the settings of that table right here from this view.
So turning off Quick Select in 3D, | find primarily useful when you want to see through a window or have
some other fine control for selecting things. Now if | had this turned off, | can't select the roof by its top,
but when | go to an edge, it will allow me to select it. So with Quick Select off, it will select by corner or
in the cases of many elements, the edge of the element will allow it to be selected there. [0:30:38]

So let's look at another way that we can select elements which is the Marquee tool here in 3D. So let
me go and - our 3D window right now is sized a little funny, so let me just bring that to a proper
convenient size here. So let's say that | go to the Arrow tool. And in the same way, if | go to, if | hit
Command+A, it will select everything. If | go to the Wall tool, Command+A will select all walls. So, you
can actually affect all the walls if you wish or use the Find and Select. So if | do the Find and Select like
this or | eyedrop a particular wall type here, and then perhaps use the layer, now it's on the exterior
layer, hit the plus sign, now it's selecting only the walls that are on the exterior layer, but on all stories.
[0:31:31]

So it's not going to affect interior walls but it will affect all exterior walls. In the same way, | can go and
eyedrop let's say a window. And then if | turn off the layer, layer probably doesn't matter too much, but
if | remove that, | can select all windows. So | could perhaps change the material of all the windows or

8 Best Practices Course — Week 15 Part 2 — © copyright 2012 by Eric Bobrow



some other styling, maybe make the casing wider for every window or | can use all the combination of
Find and Select to be very specific and find all windows of a certain type or size that | want to modify. So
in 3D, you can work across stories and affect multiple elements that otherwise, when you're on a floor
plan, you would only see on a particular single story at a time. [0:32:15]

Now there is an option for using the marquee in 3D. And so let me show you how that works, it's not
widely used, but when | activate the Marquee tool, there is an option for Geometry, just like we have on
the floor plan. But we have three unique versions in 3D that will draw a volume and then allow us to
select anything within that volume. And then we have a fourth one that will select just a 2D graphic. So
let me demonstrate. The simplest thing is the one with the rectangular selection here, but we can do a
polygon. Now, if I'm set up without having done anything special, then when | click to draw this box, it
will be drawing it based on the project zero. [0:33:03]

Now I've just draw a rectangle, and then | have a choice after the second click to say the height. Now
you can see there's this thing floating around in space. If | orbit around a little bit, you'll see it's near
that tree. And if | do Command+A, it will select everything within that area. Now it would have been
easier just to select the tree directly, but suppose you have a building off to the side, or a structure, a
gate, some other things. You can use this to select a bunch of elements perhaps in a certain area. Let's
just say if | wanted to select the entire house. Let me hit the Esc key air and start in this corner, and | can
draw this out until | get beyond the house, and then perhaps draw this up a little bit. [0:33:50]

Now | will show you, if | draw it only up to a small height and then do Command+A4, it will select
everything on the lower story. But, if | start this over and do a similar selection here, and then take it up
higher, and then do Command +A, it will select everything on multiple stories. Or basically within that
volume there. It also happened to get the tree because | guess it touched part of the tree in there. Now
this marquee is drawn at the project zero as far as | can tell. The only way that | found to select things
on a different story or at a different height is to use the option called the Gravity. So Gravity is this little
icon in the toolbar here that looks like a plumb bob. And | can choose whether I'm going to gravitate to
a slab, a roof, a shell or a mesh. The shell of course being something new in ArchiCAD 15. [0:34:47]

Let's say that | gravitate to a roof, and | zoom in on this area. Then | can draw the marquee up in this
area of the roof. And then if | do Command+A, you will see how it selects just the roof, and in this case,
the framing members that are in model, the structural pieces there. Let me rotate around, and let me
say that | want to select things that were on a certain floor. So let me go and switch my gravitation to
the slab. Now | will zoom in on this, and perhaps | go on top of the slab and draw a box here and take it
up. And you can see as | rotate around that this area that it's selecting or that it's enclosing in a volume
is clearly at this particular height in space. And if | do Command+A, it will select everything within that
area. [0:35:40]

Now it happened to touch those walls, so if | didn't want that, | would want to be perhaps more precise.
If I just wanted the railings or something like that - let me go and start over here and perhaps take this
not quite as far up. And if | do Command+A, you will see it select just the railings. So this can be a little
awkward to work with, so | don't use it frequently, but it can be nice. And just know that it will do it at
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the project zero, or if you use the gravitation option here, then it will look for a roof or a slab or a mesh
for your visual feedback. As you click, it will start at a certain height based on whatever element you're
telling it to gravitate to. So I'll just turn off the gravity here so it's not active there. [0:36:29]

Now there is another option for the marquee, there is a polygon option, which you could obviously click
on a series of points or a rotated rectangle which would give you some different options that you can
experiment with. But this one is quite different. And that is the flat selection. And that is copying a
graphic. So if | go and click now it's drawing a simple rectangle. And | can go and say Copy. And what is
going to do is it's going to copy this picture. Now if | go back to the floor plan here - and let's just zoom
out a little bit - | can paste this picture. And you can see this picture, if | move it around is within a
marqueed area. And when | click inside it, it drops the picture in. [0:37:16]

So here we have this picture. It's not to scale of course, because it is just an angled view. And | can resize
it; | can use the resize in the pet palette to make it whatever size I'd like. So this is a screen capture
essentially of the open GL based 3D view. And we can use it for a variety of presentations. You can
paste it onto layout sheets, you can paste into a worksheet, etc. Now let's go back to that 3D view, and
let's take a different type of view. If | go to the View menu, and | go to 3D View Mode, and switch it to
Internal 3D Engine, we are going to see the screen change a little bit because ArchiCAD is now doing
something in terms of creating that view that is more CAD like, rather than visualization based.

[0:38:08]

What that means it is when | do the Copy command; it will ask me what | want to copy. Do | want to
copy a screenshot, a drawing or a scale drawing? A screenshot would be similar to what we just had; a
drawing would be something that would be based on the size of what we're looking at onscreen. But the
one | find most useful is scale drawing. Everything in ArchiCAD in scaled in a similar way to the plan or
any detail drawing. It has a certain real building scale. Now | can say that | would like to copy the edges
which would be just the line work or possibly edges and polygons. Let's just select all of this and say OK.
[0:38:47]

So I've now selected this to copy. And if | go back to the floor plan and paste, we're going to see a
different thing. Let me just move this into position and we will zoom in on it. And what you'll see is that
it actually is a series of lines and fills. These can be a little bit hard to work with, because there are
overlapping fills and things like that. You may find that the option to consolidate lines and fills may help.
Frankly | don't use this with all of the polygon elements. In other words, | just use it for line work. And
let me show you how that works. So let's say this would be an experiment but | probably wouldn't use
that. [0:39:29]

So here is a good example that just came in a question today from one of our clients, one of the
members of the Best Practices course. Suppose that | wanted to give information for a complex roof for
how the actual size of the elements would be, that would have to be laid out by the carpenter. When
we are looking at a plan view, we're projecting this down onto the plan, so it's not actually able to be
measured the same way it would be out in the field. How long is the diagonal member, this one that's
rising on an angle? We can't really get that. But, if we turn using the View menu, 3D Navigation Extras,
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Look to Perpendicular. I'll click Surface. And | click on this Surface, you'll see now as | zoom inon it I'm
looking straight on the surface, and we can see the side of this wall. Everything is sort of tilted based on
that look. [0:40:23]

Now if | use the Marquee tool and select this area and go to the Copy, | might simply want to say give
me edges only. So now I'm only going to get line work. And | will say OK. Now I've copied just the line
work, and I'll go back to the floor plan. And let me paste this in. And we'll just zoom out a little bit here
and pop it wherever it would be convenient. Now at this point, if | measure from this point here along,
this is 7'3" and a fraction inches. Let's just see what this looks like on the plan. If | go up to the upper
story here and Fit in Window, and we measure this, if | measure this from this point to this point here,
we have that same dimension. So it's exactly correct. In fact, let me just paste in, since it would still be
on the clipboard, the same drawing that | just had. So I'll just paste in here. And maybe we'll rotate it
just for convenience. So after | drop it in, I'm going to rotate it. [0:41:34]

Now here is a trick. If | wanted to - when | rotate this, | need to select these elements. Now since |
moved them off to the side, | could use the Arrow tool and select them, but sometimes you need to
paste things into the middle of a model or just the middle of an area. And that you still need to select
them to change their layer or something else. So here's what you can do. You can undo the paste and
then redo. And when you redo here, the elements are selected. That allows you to very easily go for
example and rotate or change an attribute. Let me just move this along here and just rotate it into
position. [0:42:16]

So now if we look at this here, the vertical distance is the same. But let's just measure the dimension
along here. So if | measure from this point here along this angle, it says its 8'2" and a fraction, whereas if
| measure from this point along here to there, it's 8'4" and a fraction. So because it's on an angle, it
actually is a different distance. Obviously that structural member would have to be a different size. So
let's just dimension that. If | go to the Dimension tool | can dimension any of these things. So if | click -
let's just zoom in on this perhaps and turn ourselves to hairline so turn off true line weight. And say I'm
going to dimension from this point and down to this point here precisely, and then double click.
[0:43:11]

Now at this point as I'm dimensioning, | have the standard dimension options that will either give me
vertical or horizontal dimensions. But if | switch this to angled then | have multiple choices. And so for
example | can choose to do it on this angle. Here is the horizontal, here is the angled, here is the vertical.
And you'll notice this circle. If | basically move my mouse somewhere within the control of this part of
the circle, | can get the diagonal measurement. So you can see here is the 8'4", and if | were to
dimension this on just a standard view for a similar element here, that's going to be the 8'2". So you can
see that we're getting a precise framing size as opposed to the projection down to the floor plan.
[0:44:02]

So this concludes our lesson on power selection techniques. | look forward to getting your comments
and questions on the page down below. This has been Eric Bobrow, thanks for watching.

[END OF AUDIO, 0:44:18]
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